
ReferenZing Help

Click on a topic to get help.

General Overview
Navigating ReferenZing
Finding Words and Topics in ReferenZing
Adding ReferenZing to your Word Processor
Using Word Search
Copying Information
Printing Information
Arranging the Screen
Using Menus
Using the Toolbar

Copyright (c) 1994, Great Bear Technology. All rights reserved.
ReferenZing Help Version 0.933



General Overview

Use ReferenZing to help you with all kinds of writing, from book reports and 
term papers to business proposals and plans.    ReferenZing includes a 
popular dictionary, a thesaurus, and an encyclopedia of people, places, and 
things.

Open these references by clicking on the appropriate toolbar buttons:

    Webster Handy College Dictionary

    Roget's College Thesaurus

    New American Desk Encyclopedia

To see the entry for a word, find it in the Keyword Index and double-click it. 
You can also type the word into the Keyword Input Field and press Enter.

With ReferenZing, you can:

    Look up the definition of a word

    Find the pronunciation or syllabication of a word

    Find synonyms for a word

    Find a word when you only know the meaning

    Find a word that will fit a crossword puzzle

    Find words that rhyme

    Solve anagrams



    Solve word jumbles



Navigating ReferenZing

Start at the main window when you want to use the dictionary, thesaurus or 
encyclopedia.

To open the dictionary, thesaurus or encyclopedia, click the appropriate 
button on the toolbar.    You can open one, two, or three references at once.

Use the alphabet tabs and Keyword Index to find the word or topic you want. 
You can also type the word (or the first part of the word) into the Keyword 
Input Field.

Double click on any word in the Entry window to automatically look up that 
word.

Click on the History button next to the Keyword Input Field to look up a word 
you selected previously.

Use the menus to work with the current word or topic.

See Also:
Finding Words and Topics in ReferenZing
Using Menus



Finding Words and Topics in ReferenZing
ReferenZing includes three references:

    Webster Handy College Dictionary

    Roget's College Thesaurus

    New American Desk Encyclopedia

To open a reference, click on the appropriate button.    All three may be open 
at once, allowing you to look up the same word in all references at the same 
time.

Looking up words in Webster Handy College Dictionary:

1.    Select the Dictionary button on the toolbar to open the 
dictionary.

2.    Click on an alphabet tab and scroll the Keyword Index to find the
word.    You can also type the word into the Keyword Input Field.

3.    Double-click the word or highlight the word and press Enter.    
The definition appears to the right of the keyword index.

For Example:
Find what the word kilter means.    Click on the K tab and scroll the index to 
find the word kilter.    Double-click on the word kilter to view the definition:

kilter, a good working condition.

Looking up words in Roget's College Thesaurus:

1.    Select the Thesaurus button on the toolbar to open the 
thesaurus.

2.    Click on an alphabet tab and scroll the Keyword Index to find the
word.
.    You can also type the word into the Keyword Input Field.



3.    Double-click the word or highlight the word and press Enter.    
The synonyms and antonyms appear to the right of the keyword 
index.

4.    Double-click uppercase synonyms to see more synonyms for the 
word you entered.

For example:
Find synonyms for the word mountain.    Click the M tab and scroll the index 
to find the word mountain.    Double-click on the word mountain to view the 
synonyms:

hill, peak, elevation, alp, and mount. See HEIGHT.
Double-click HEIGHT to see more synonyms relating to the word mountain.

Looking up topics in the New American Desk Encyclopedia:

1.    Select the Encyclopedia button on the toolbar to open the 
encyclopedia.

2.    Click on an alphabet tab and scroll the Keyword Index to find the
topic.

3.    Double-click the topic or highlight the topic and press Enter.    
The information on the selected topic appears to the right of the 
keyword index.

4.    Click on the Map icon on the toolbar to view the map, if 
available.    Only geographic entries have maps.    Click on any green 
area of the map to automatically look up the encyclopedia entry for 
that location.    Copy the map by clicking the Copy button.    Then 
paste the picture into your paint program.

For example:
Find information on Argentina.    Click on the A tab and scroll the index to find
the topic Argentina.    Double-click on the topic Argentina to view information.
You can also click the Map icon to see the map of this country.



Adding ReferenZing to your Word Processor
You can install ReferenZing into the menu system of your word processor.    
After doing this, you can start or switch to ReferenZing without leaving your 
word processor.

For Microsoft Word for Windows Release 2.X:

1.  Copy the file WORD2.DOC from the ReferenZing directory 
(usually this is C:\REFERENZ) to your Word document directory 
(usually this is C:\WINWORD).    If you are not sure how to copy a 
file,    open the File Manager, click Help, and search for help on 
copying files.

2.    Open this file with Microsoft Word and follow the instructions.

Note:    The file WORD2.DOC must be opened in your word directory, or 
this will not work properly.

For Microsoft Word for Windows Release 6.X:

1.  Copy the file WORD6.DOC from the ReferenZing directory 
(usually this is C:\REFERENZ) to your Word document directory 
(usually this is C:\WINWORD).    If you are not sure how to copy a 
file,    open the File Manager, click Help, and search for help on 
copying files.

2.    Open this file with Microsoft Word and follow the instructions. 

Note:    The file WORD6.DOC must be opened in your word directory, or 
this will not work properly.

For WordPerfect for Windows 6.X:

1.    Start WordPerfect and choose Tools/Macro/Play.

2.    Enter the path of the ReferenZing directory followed by the file 
name of the macro INSTALH6.WCM.    For example:    C:\REFERENZ\
INSTALH6.WCM.

For Lotus Ami Pro:

1.    Start Ami Pro and choose Tools/Macros/Playback.



2.    Enter the path of the ReferenZing directory followed by the file 
name of the macro INSTALL.SMM.    For example:
C:\REFERENZ\INSTALL.SMM.

Note:    To optimize performance with your word processor, select AutoPaste 
from the ReferenZing Options Menu.    This will automatically paste whatever 
word is on the Windows clipboard into the Keyword Input Field when 
ReferenZing is activated from within your word processor.
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How Word Search Works
Search 
Type:

Searches in: Finds:

Partial Word The keyword index of every open 
reference.

Keywords with a specified 
beginning and/or ending.

Advanced The keyword index and the 
complete text of each entry of 
every open reference.

Keywords that match the search 
expression.

Rhymes The keyword index of the 
Dictionary.

Keywords that rhyme with the 
specified word.

Crosswords The keyword index of every open 
reference.
The complete text of each entry 
of every open reference is 
searched for the clue word.

Keywords that match the search 
expression.
Keywords that match the search 
expression and include the clue 
word in their entry text.

Anagrams The keyword index of every open 
reference.

Keywords that contain the same 
letters as the specified word.

Jumbles The keyword index of every open 
reference.

Keywords that contain the 
specified letters.



Using Partial Word Search

Use Partial Word Search to find words and topics you cannot spell or words 
with a common beginning or ending.    To open the Partial Word Search 
window click on the Word Search button and then click on Partial Word.    The
following window appears:

To perform a Partial Word Search:

1.    Open the reference you want to use.    For our example, to search 
in the dictionary only, open the dictionary and close the thesaurus and 
encyclopedia.

2.    Click the Word Search button.    In the Word Search window, select 
Partial Word.

3.    Enter the starting and/or ending letters to search for a word.

4.    Click Search or press Enter.

5.    The results of the search appear in the Results List.    Double-click 
on a word in the results list to view the entry in the main window.

For example:
You want to check the definition for perspicacity, but you are not sure how to 
spell it.    Use Partial Word Search.

Open the dictionary and close the other references.    Click Word Search.    
Click Partial Word in the search window.    Type in per as the starting letters, 
then press the Tab key and type ty as the ending letters.    Click Search or 
press Enter. The search finds several keywords.    Scroll down the Results List 



until you find perspicacity.    Double-click the word to view the definition:

perspicacity, mentally acute.

See Also:
Using Advanced Search
Using Rhymes Search
Using Crosswords Search
Using Anagrams Search
Using Jumbles Search
How Word Search Works



Using Advanced Search

Use Advanced Search to search through all words and topics, including the 
words that appear in dictionary definitions and encyclopedia entries.    Note 
that some search methods (Partial word, Rhymes, Crosswords, Anagrams, 
and Jumbles) only search in the keyword index and ignore the words that are 
in the entry.

Using Advanced Search, you may formulate complex multi-word search 
expressions using Boolean operators.    Additionally, the two conventional MS-
DOS wildcard characters may be substituted for unknown letters.    To open 
the Advanced Search window click on the Word Search button and then click 
on Advanced Search.    The following window appears:

To perform an Advanced Search:

1.  Select the reference you want to search.    For our example, select
the encyclopedia and close the dictionary and thesaurus to search 
only in encyclopedia entries.

2.  Click the Word Search button.    In the Word Search window, 
select Advanced Search.

3.  Enter the words or topics you would like to find.

4.    Click Search or press Enter.

5.  The results of the search appear in the Results List.    Double-click
on words in the Results List to view the complete entry in the main 
windows.



To Perform an Advanced Search using Boolean operators:

Boolean operators are AND, OR, and NOT.    These operators enable you to 
broaden or narrow your search.    The operator always goes between your 
two search words and should be in uppercase.

The operators use the following logic. X and Y represent words you include in
a search.

x AND y
If both x and y appear in the entry, the keyword will appear in the 
Results List.    Use AND when you want to narrow your search.

For example: yellow AND flowers will find all of the keywords whose 
entries contain both the word yellow and the word flowers.

x OR y
If either x or y appear in the entry, the keyword will appear in the 
results list.    Use OR when you want to broaden your search.

For example: yellow OR flowers will find all of the keywords whose 
entries contain either the word yellow, the word flowers, or both 
words.

x NOT y
If x appears in the entry, but y does not, then the keyword will 
appear in the results list. Use NOT when you want to narrow your 
search.

For example: yellow NOT flowers will find all of the keywords whose 
entries contain the word yellow but not the word flowers.

Step by step instructions:

1.  Select the reference you want to search.    For our example, select
the dictionary and close the encyclopedia and the thesaurus to 
search only in dictionary definitions.

2.  Click the Word Search button.    In the Word Search window, 
select Advanced Search.



3.  Enter the search expression.    Type in two words separated by a 
logic expression.    The logic expression should be in uppercase.

For example: type in yellow AND flowers to find aster and buttercup.

4.    Click Search or press Enter.

5.  The results of the search appear in the Results List.    Double-click
on words in the Results List to view the complete entry in the main 
windows.

To Perform an Advanced Search using wildcard characters:

Wildcard characters are the asterisk ("*") and the question mark ("?").    The 
asterisk substitutes for any number of characters (including zero).    The 
question mark substitutes for a single character.

Wildcards work as follows.    X and Y represent other letters in the search 
word.

xy*
Any word that starts with xy and ends with any number of characters
will appear in the Results List.

For example: type in sp* (the letters sp followed by the asterisk 
character).    The results list will include spa, space, spade, span, and
spy.

xy?
Any three letter word that starts with xy and ends with any letter will
appear in the results list.

For example: type in sp? (the letters sp followed by a question 
mark).    The results list will include spa and spy.

Step by step instructions:

1.  Select the reference you want to search.    For our example, select
the dictionary and close the encyclopedia and the thesaurus to 
search only in dictionary definitions.

2.  Click the Word Search button.    In the Word Search window, 



select Advanced Search.

3.  Enter the search expression, replacing unknown letters with 
wildcard characters.

For example: type in flower* to search for words that contain flower, 
flowers, or flowering.

4.    Click Search or press Enter.

5.  The results of the search appear in the Results List.    Double-click
on words in the Results List to view the complete entry in the main 
windows.

To Perform an Advanced Search using a phrase:

A phrase is more than one word appearing together.    If you enter a phrase, 
the Advanced Search will find the entries that contain the same sequence of 
words.

The search uses the following logic. X and Y represent words you include in a 
search.

xy
Any entry that includes the words xy in sequence will appear in the 
Results List.

For example: type in civil war.    The results list will include entries 
which contain the phrase civil war like:    Abolitionism, Battle of 
Antietam, Confederate States of America, Battle of Gettysburg, 
Abraham Lincoln, Mozambique, Spanish Civil War, and Union of 
Soviet Socialist Republics (USSR).

Step by step instructions:

1.  Select the reference you want to search.    For this example, 
select the encyclopedia and close the dictionary and the thesaurus 
to search only in encyclopedia topics.

2.  Click the Word Search button.    In the Word Search window, 
select Advanced Search.



3.  Enter a phrase for the search expression.

For example: type in New England to search for entries that contain 
this phrase like:  cod, Connecticut, elm, Plymouth colony, and United 
States of America.

4.    Click Search or press Enter.

5.  The results of the search appear in the Results List.    Double-click
on words in the Results List to view the complete entry in the main 
window.

To Perform an Advanced Search using parenthesis:

If your search expression is complex, you may wish to "force" the evaluation 
order of the operators by using parenthesis marks.    The behavior is similar 
to using parenthesis in an algebraic expression. 

The normal order of evaluation is AND, NOT, and then OR.    That is, in a 
complex search expression containing more than one operator, and when 
there are no parenthesis to force the order, the AND operator will be 
evaluated first, the NOT operator next, and the OR operator last.

For example:

The expression:

"red OR white AND blue"

evaluates as "red OR (white AND blue)".    This will find items that are either 
red or are both white and blue.

You could "force" the order otherwise by using parenthesis in your 
expression:

"(red OR white) AND blue" will find items that are blue and also either 
red or white.

See Also:
Using Partial Word Search
Using Rhymes Search
Using Crosswords Search
Using Anagrams Search
Using Jumbles Search
How Word Search Works





Using Rhymes Search

Use Rhymes Search to find all of the words that rhyme with your word.    
Rhymes are words that share a common ending sound.    Rhyme searches 
use only keywords from the dictionary so make sure the dictionary is open.    
The thesaurus and the encyclopedia are not used for rhymes.    To open the 
Rhymes Search window click on the Word Search button and then click on 
Rhymes Search.    The following window appears:

To perform a Rhymes Search:

1.    Click the Dictionary button to open the Dictionary.

2.    Click the Word Search button.    In the Word Search window, 
select Rhymes.

3.    Enter the word to rhyme.

4.    Click Search or press Enter.

5.    The results of the search appear in the Results List.

For example:

If you want to find words that rhyme with the word time, use Rhymes Search.
Click Word Search and then select Rhymes. Now, type time. Then click 
Search or press Enter. The search finds keywords that rhyme with time like:    
sublime, lime, and prime.    If you want to view the definition of the word, 
double-click it.



Special note on Rhymes Search:

There are many keywords in the dictionary that are multi-word keywords, 
such as calling card.    These multi-word keywords are often an alternate form
of a single-word keyword. For example, calling card is an alternate form of 
calling.    In such cases, although the alternate form is listed in the Results 
List, the word that satisfies the rhyme is the primary form of the word.

See also:
Using Partial Word Search
Using Advanced Search
Using Crosswords Search
Using Anagrams Search
Using Jumbles Search
How Word Search Works



Using Crosswords Search

Use Crosswords Search to find words by entering the letters you know, 
leaving the boxes empty for the letters you don't know.    To open the 
Crosswords Search window click on the Word Search button and then click on
Crosswords.    The following window appears:

To perform a Crosswords Search:

1.    Open all the references to increase your chance of finding the 
correct word.

2.    Click the Word Search button.    In the Word Search window, select 
Crosswords.

3.    Enter the number of letters in the word you want to find.

4.  Enter the letters that you know are in the word by typing them in 
the proper boxes.    Leave the boxes empty for the letters you do not 
know.

5.    Click Search or press Enter.

6.    The results of the search appear in the Results List.    Double-click 
on a word in the results list to view the entry in the main window.

For example:

You are searching for a word in a crossword puzzle with five letters beginning
with BL.    The clue given is bored.    Use Crosswords Search.



Open all the references.    Click Word Search.    Click Crosswords in the search
window.    Enter 5 for the number of letters in the word.    Type B and L in the 
first two boxes and leave the other three boxes empty.    Then click Search or 
press Enter. The search finds several words.    Scroll down the Results List 
until you find a word which matches the clue.    Double-click the word to view 
the definition.    If you would like to narrow the search, enter bored as the 
clue.    The search finds the word blasé.

satiated with pleasure; bored.

Special note on using a Clue word:

It will often be easier to not specify a clue word.    If the entry portion of the 
correct keyword does not actually contain the word you have specified for 
the clue, your keyword will not be in the results list.

 For example:

You are searching for a word in a crossword puzzle with five letters beginning
with BL.    The clue given is indifferent.

The correct word is blasé, however, it will not be found because the word 
bored, and not the word indifferent, appears in the ReferenZing definition for 
the word blasé.

See also:
Using Partial Word Search
Using Advanced Search
Using Rhymes Search
Using Anagrams Search
Using Jumbles Search
How Word Search Works



Using Anagrams Search

Use Anagrams Search to find the anagrams for a word.    Anagrams are words
which use the same letters as another word.    To open the Anagrams Search 
window click on the Word Search button and then click on Anagrams.    The 
following window appears:

To perform an Anagrams Search:

1. Open all the references to increase the number of anagrams found.

2.    Click the Word Search button.    In the Word Search window, select 
Anagrams.

3.    Enter a word to find the anagrams for that word.    If you want to 
specify the minimum number of letters in the anagrams found, enter 
the number in the Minimum Number of Letters field.    The search will 
find anagrams of that length or longer.    If the number of letters in the 
anagrams found does not matter, leave the number at 1.

4.    Click Search or press Enter.

5.    The results of the search appear in the Results List.    Double-click 
on a word in the results list to view the entry in the main window.

For example:

You want to find words which use the same letters as the word great.    Use 
Anagrams Search.

Open all the references.    Click Word Search.    Click Anagrams in the Search 



window.    Type in great as the word.    Leave the Minimum Number of Letters 
field at 1.    Then select Search or press Enter. The search finds many 
keywords.    Scroll down the Results List until you find the word you want to 
use.    Double-click the word to view the definition.    If you want to find words 
with only four letters, enter 4 in the Minimum Number of Letters field.    This 
search finds fewer keywords.

See also:
Using Partial Word Search
Using Advanced Search
Using Crosswords Search
Using Rhymes Search
Using Jumbles Search
How Word Search Works



Using Jumbles Search

Use Jumbles Search to find words containing the selected letters.    To open 
the Jumbles Search window click on the Word Search button and then click 
on Jumbles.    The following window appears:

To perform a Jumbles Search:

1. Open all the references to increase the number of words found.

2.    Click the Word Search button.    In the Word Search window, select 
Jumbles.

3.    Enter the letters of the jumble word.

4. If you want to specify a minimum number of letters, enter the 
number in the Minimum Number of Letters field. The search will find 
words of that length and longer.

4.    Click Search or press Enter.

5.    The results of the search appear in the Results List.    Double-click 
on a word in the results list to view the entry in the main window.

For example:
You are having trouble figuring out what word is formed from the following 
jumble: srytoes.    Use Jumbles Search.

Open all the references.    Click Word Search.    Click Jumbles in the search 
window.    Type in srytoes as the jumble word.    Leave the Number of Letters 
field at 1.    Then select Search or press Enter. The search finds several 



keywords.    Scroll down the Results List until you find the correct word.    
Double-click the word to view the definition.    If you want to find words which
are the same length as the jumble word, enter 7 in the Minimum Number of 
Letters field.    This search finds the keyword oysters.

See also:
Using Partial Word Search
Using Advanced Search
Using Crosswords Search
Using Anagrams Search
Using Rhymes Search
How Word Search Works



Copying Information

You can copy information from ReferenZing to the Windows clipboard and 
paste it into other Windows applications, such as your word processor.    Note 
that this text will be unformatted.    Use your word processor to format it for 
line length, etc.

To copy the current keyword:

Select the keyword you want to copy by double-clicking on a word in the 
Keyword Index list.    The entry for that word will appear.    Now, click the copy
icon.    Switch to your other application.    While you are in the other 
application, click the cursor where you want the word to appear and pull 
down the Edit menu. Now, select Paste.    The text from ReferenZing will now 
appear in the other application.    Note that this text will be unformatted.    
Format it in your word processor.

To copy the current keyword and its entries:

Select the keyword you want to copy by double-clicking on a word in the 
keyword index list.    The entry for that word will appear.    Now, pull down the 
Edit menu and select Copy Entry.    The text will be copied to the Windows 
Clipboard.

To copy the Search Results List:

In the Search window, enter a search expression and click Enter.    After the 
Results List has been compiled, pull down the Edit Menu and select Copy 
Search Results.    The results list will be copied to the Windows clipboard.



Printing Information

To print the current keyword and entry:

Select the keyword you want to print by double-clicking on a word in the 
Keyword Index list.    The entry for that word will appear.    Now, click the Print
icon.

To print the Search Results:

In the Search window, enter a search expression and click Enter.    After the 
Results List has been compiled, pull down the File Menu and select Print 
Search Results.    The results list will print on the current default printer.



How to Arrange the Screen
There are three references available within ReferenZing.    With one reference
open, that reference uses the entire main window area.    Open a new 
reference and the elements within the main window automatically resize to 
accommodate the new reference.

Pull down the Options menu to enable and disable the status line and 
alphabet tabs.

The splitter bar allows you to devote more space to the elements on the left, 
such as the index list, and less to the elements on the right. To move the 
splitter bar, move the mouse over the bar until it changes to a double arrow, 
then click on it and drag it to a new location.

splitter bar

To move a window, click on the title bar of a window and drag it to a new 
location.

To resize a window, move the mouse over the window border until it changes
to a double arrow, then drag the border to a new size.

Click on the Maximize button (an upward-pointing triangle to the right of the 
title bar) to enlarge it to the fullest possible size.

Click on the Minimize button (a downward-pointing triangle to the right of the
title bar) to reduce a window to its icon. Double-click the minimized icon to 
re-open the window.



Using Menus

File Menu Commands
Edit Menu Commands
View Menu Commands
Options Menu Commands
Help Menu Commands



File Menu Commands

The File menu contains these commands:
 Print Current Keyword
 Print Search Results
 Print Setup
 Exit

Print Current Keyword
Prints the displayed keyword and reference definitions and entries (assuming
you have a printer installed and turned on). 
Print Search Results
Prints the search results appearing in the Results List (assuming you have a 
printer installed and turned on). 
Print Setup
Displays a dialog box in which you can change printer settings before 
printing. 
Exit
Closes ReferenZing. 

See Also
Printing Information



Edit Menu Commands

The Edit menu contains these commands:
 Copy
 Copy Entry
 Copy Search Results
 Paste
 Word Search

Copy
Copies highlighted text to the Clipboard.    This text will be unformatted.
Copy Entry
Copies the keyword and the entries of the open references to the Clipboard.   
This text will be unformatted.    Format it in your other application.
Copy Search Results
Copies the search results appearing in the Results List to the Clipboard. 
Paste
Pastes the contents of the Clipboard into the Keyword Entry Field. 
Word Search
Opens the Word Search window. 

See Also
Using Word Search
Copying Information



View Menu Commands

The View menu contains these commands:
 Dictionary
 Thesaurus
 Encyclopedia
 Search Results
 Split
 Map

Dictionary
Opens the Webster Handy College Dictionary.

Thesaurus
Opens Roget's College Thesaurus. 
Encyclopedia
Opens the New American Desk Encyclopedia. 
Search Results
Displays the Results List with the search results. 
Split
Displays the splitter which allows you to adjust the width of the Keyword 
Index and the Entry windows. 
Map
Displays a map relating to the encyclopedia entry currently selected if 
available.    Only geographical entries have maps. 

See Also
Using Word Search
Arranging the Screen



Options Menu Commands

The Options menu contains these commands:
 AutoPaste
 Alphabet Bar
 Status Bar
 Font

AutoPaste
Automatically pastes the contents of the Clipboard into the Keyword Input 
Field when ReferenZing is activated.
Alphabet Bar
Displays the options: Horizontal, Vertical and Off. The Horizontal command 
displays the alphabet bar above the index and entries.    The Vertical 
command displays the alphabet bar to the left of the index.    The Off 
command removes the alphabet bar.
Status Bar
Displays the status bar at the bottom of the screen.
Font
Allows you to change the Font, Font Size and Font Style of the text. 

See Also
Arranging the Screen



Help Menu Commands

The Help menu contains these commands:
 Contents
 About

Contents
Displays the ReferenZing Help Table of Contents. 
About
Displays a dialog box which shows the version and copyright information for 
ReferenZing. 



Using the Toolbar

The toolbar contains these command buttons:

Copy
The Copy button copies selected text to the Clipboard.    This text will be 
unformatted.

Paste
The Paste button pastes text from the Clipboard into the Keyword Input Field.

Dictionary, Thesaurus, Encyclopedia
Click Dictionary, Thesaurus, or Encyclopedia to open the selected reference.

Word Search
The Word Search button opens the Search window.

Map
The Map button displays maps for geographical entries.

Print
The Print button prints the chosen keyword and entries.



Keyword Index

Keywords from all open references appear in this list.    A tiny icon shows the source of each 
word.    Scroll to the word you are looking for using the scroll bar.    Double click the word to 
view the entry.



Keyword Input Field

The Keyword Input Field is above the Keyword Index.    Enter the word you want to find.    The 
Index will scroll to the word as you type in the letters.    For example, type in fract to scroll to 
fractal.

Use the History button to look up words previously selected.    Click on the down arrow to the
right of the input field to view the History box.    Double click the word you would like to look 
up.



Alphabet Bar

The Alphabet Bar allows you to jump directly to words that start with a specific letter.    
Select a letter by clicking on one of the alphabet tabs.    For example, if you are looking for 
the word tabernacle, click on the T alphabet tab and then scroll to the correct word and 
double click it.    You can choose the location of the Alphabet Bar from the Options Menu.



Toolbar

    The Copy button copies selected text to the Clipboard.

    The Paste button pastes text from the Clipboard into the Keyword Input Field.

    Click Dictionary, Thesaurus, or Encyclopedia to open the selected reference.

    The Word Search button opens the Search window.

    The Map button displays maps for geographical entries.

    The Print button prints the chosen keyword and entries.



Results List

The Results List is a list of all of the words found in a search.    The list appears after a 
successful search is completed.




